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1. Introduction 
 

1.1 Getting Started 
Win32Trace is a program for converting raster (bitmap) graphics into vector (tracing) formats. 

It wraps the console application AutoTrace in a convenient Windows GUI and uses the FreeImage 

graphics library to import a wide variety of raster image formats. 

 

Features of Win32Trace 

Win32Trace presents a graphical user interface for interactively converting raster files to vector 

format. You can: 

• Import raster (and vector) files from the clipboard  
• Save converted images to a variety of vector file formats  
• Determine vector properties by adjusting despeckling, noise, line properties  
• Zoom specific regions of the vector image  
• Save and retrieve customized conversion settings 

A sample screen of a Win32Trace session is shown below: 

 

1.2 FAQ 
  

Common terminology used in converting raster (bitmap/jpg/png) files into vector graphics are 

presented below:  

  

Background color  

The color of the background that should be ignored. 

  

Centerline 

Trace a character's (or pattern’s) centerline, rather than its outline. 

  

Color Count 

This sets the number of colors that the output file will contain. Maximum allowable is 256 (which is 

a lot). Setting this to 0 will perform no color reduction.  

With vector graphics, the final file size is related to the image complexity. The greater the number of 

colors, the larger the file size will be because more color primitives (vectors) will be needed. 

For best results, use the smallest number of colors that produce a satisfying vector image. For 

monochrome images, use color count = 2. For grayscale image, use color count = 0. 

  

Corner Always Threshold  

This setting (angle in degrees) forces a pixel to be marked as a corner even if it is right next to 

another pixel marked as a corner. Default is 60. 

Corner Surround  

This is the number of pixels on either side of a point to consider when determining if that point is a 

corner. The default is 4. 

Corner Threshold  

http://autotrace.sourceforge.net/
http://freeimage.sourceforge.net/
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This setting (angle in degrees) determines if a pixel is marked as a corner. If a pixel, its 

predecessor(s), and its successor(s) meet at an angle smaller than this, it is marked as a corner. 

Default is 100. 

  

Despeckle Level 

This sets the degree to which Autotrace blurs regions with similar colors when searching for edges. 

Too little despeckling will cause your image to have wiggly vectors caused by discrete pixels; too 

much and your image may turn out looking blurred beyond recognition. 

  

Error Threshold  

This setting controls the subdivision of fitted curves. To achieve a closer approximation to the 

original curve, use lower values for this. Pixels that depart by more pixels than this from the original 

curve will force subdivision of the spline. Default is 2.0. 

  

Filter Iterations  

This sets the number of times curves will be smoothed before fitting to a spline. Default is 4. 

Line Reversion Threshold 

The line reversion threshold attempts to do the same thing as Line Threshold: reduce nearly-

straight spline curves to simpler lines. But whereas Line Threshold simply judges the distance 

between the curve and its straight line, Line Reversion Threshold weights this measurement by the 

length of the spline. Default is 0.01. 

Line Threshold  

If the spline curve approximation for a vector is not more than this distance (in pixel units) away 

from the straight line defined by its endpoints, then the curve will be simplified to a straight line. 

Default is 1.  

Preserve Width 

This setting preserves the width of lines when using the Centerline option. The default is to thin 

them.  

Remove Adjacent Corners 

Remove corners that are next to each other. 

Tangent Surround  

The number of points on either side of a point used to compute the tangent vector at that point. 

Default is 3. 

Trace Center Lines 

When this option is selected, the workflow traces region centerlines rather than the regions 

themselves. This is generally not useful for image transformation, but is however sometimes helpful 

when looking for text within an image 

  

Width Weight Factor 

This setting influences the extent to which line width influences the vectorization when deciding 

which line segments to join together.  

  

Commands 

 File menu 

 Edit menu 

 View menu 

 Help menu 
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2. Menus 
 

2.1 File menu 
New  Opens a new Win32Trace editing session, keeping the present one open. 

Open  Opens an existing document.  

Save  Saves present document. 

Save As  Saves an opened document to a specified file name. 

Close  Closes current document. 

MRU List  Shows list of recently used documents. 

 Exit Exits Win32Trace. 

 

2.2 Edit menu 
Paste  Pastes raster data from the clipboard into the Win32Trace viewing pane. 

Copy Copies data onto clipboard 

Save Settings  Saves present conversion settings in a custom settings file for later use. 

Restore Settings  Retrieves and applies settings previously saved in a custom settings file. 

 

2.3 View menu 
Zoom Out  Magnifies view of image 

Zoom In  Decreases size of image 

Toolbar  Shows or hides the toolbar. 

Status Bar  Shows or hides the status bar.  

 

2.4 Help menu 
The Help menu offers the following commands, which provide you assistance with this application: 

Help 

Topics  
Offers you an index to topics on which you can get help. 

Help 

Manual 
Displays the help manual. 

About  Displays the version number of this application. 

 

3. File menu 
 

3.1 New 
Use this command to open a new editing session. The current session file remains open. You can 

switch working sessions from the  Windows menu.  
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3.2 Open 
Use this command to open an existing raster and view it in a new window. You can only open a 

single document at a time for tracing.  

Use the Paste command to copy a raster (or vector) file from the clipboard.  

Shortcuts 

Toolbar:   

Keys:      CTRL+O 

3.3 Save 
 

3.4 Save As 
Use this command to save and name the active document. Win32Trace displays the Save As 

dialog box so you can rename your document and choose the vector graphics format for the 

saved file.  

To save a document with its existing name and directory, use the Save command . 

3.5 Close 
Use this command to close the active window.  

Double-clicking a Control-menu box is the same as choosing the Close command.  

 

Note: If you have multiple windows open for a single document, the Close command on the 

document Control menu closes only one window at a time. You can close all windows at once with 

the Close command on the File menu.  

Shortcuts 

Keys:      CTRL+F4 closes a document window  

ALT+F4 closes the Win32Trace window  

3.6 MRU List 
Use the numbers and filenames listed at the bottom of the File menu to open the last four 

documents you closed. Choose the number that corresponds with the document you want to open. 

3.7 Exit 
Use this command to end your Win32Trace session. You can also use the Close command on the 

application Control menu. Win32Trace prompts you to save documents with unsaved changes.  

Shortcuts 

Mouse:Double-click the application's Control menu button.  

 

Keys:   ALT+F4 

afxc67ad.htm
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4. Edit Menu 
 

4.1 Paste 
Use this command to insert a copy of the clipboard contents into the raster view window. This 

command is unavailable if the clipboard is empty. This is one way of importing unsupported file 

types (such as vector format files, for example) into Win32Trace, using an editor that can read the 

input file and export it as a bitmap (or metafile) through the clipboard.  

Shortcuts 

Toolbar:  

Keys:CTRL+V 

4.2 Copy 
 

4.3 Save Settings 
Saves present conversion settings in a settings file for retrieval.  

4.4 Restore Settings 
Restores conversion settings that were previously stored in a settings file.  

5. View menu 
 

5.1 Zoom out 
Zoom out decreases the magnification (by 2X) of the vectorized image each time it is clicked. It 

is the inverse of the zoom in  operation. 

Shortcuts 

Toolbar:   Click the application's Zoom-out menu button.  

 

5.2 Zoom In 
Zoom in magnifies (by 2X) the view of the vectorized image each time it is clicked. (Note, however, 

that the actual vector image size is left unchanged.) The position of the viewable area of the vector 

image can be changed by moving the mouse over the raster image to the desired coordinates.  

Shortcuts 

Toolbar:   Click the application's Zoom-in menu button.  

 

5.3 Status Bar 
Use this command to display and hide the Status Bar, which describes the action to be executed by 

the selected menu item or depressed toolbar button, and keyboard latch state. A check mark 

appears next to the menu item when the Status Bar is displayed.  

See Status Bar for help on using the status bar.  
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5.4 Toolbar 
Use this command to display and hide the Toolbar, which includes buttons for some of the most 

common commands in Win32Trace, such as File Open. A check mark appears next to the menu 

item when the Toolbar is displayed.  

See Toolbar for help on using the toolbar.  

6. Windows menu 
 

6.1 New 
Use this command to open a new window with the same contents as the active window. You can 

open multiple document windows to display different parts or views of a document at the same 

time. If you change the contents in one window, all other windows containing the same document 

reflect those changes. When you open a new window, it becomes the active window and is 

displayed on top of all other open windows. 

6.2 Cascade 
Use this command to arrange multiple opened windows in an overlapped fashion.  

6.3 Tile 
Use this command to arrange multiple opened windows in a non-overlapped fashion.  

6.4 1,2,... 
Win32Trace displays a list of currently open document windows at the bottom of the Window menu. 

A check mark appears in front of the document name of the active window. Choose a document 

from this list to make its window active.  

7. Help menu 

7.1 Help Topics 
Use this command to display the opening screen of Help. From the opening screen, you can jump 

to step-by-step instructions for using Win32Trace and various types of reference information.  

Once you open Help, you can click the Contents button whenever you want to return to the opening 

screen.  

7.2 Help Manual 
Use this command for a glossary of terms used in Win32Trace.  

7.3 About 
Use this command to display the copyright notice and version number of your copy of Win32Trace.  

7.4 Context Help 
Use the Context Help command to obtain help on some portion of Win32Trace. When you choose 

the Toolbar's Context Help button, the mouse pointer will change to an arrow and question mark. 

Then click somewhere in the Win32Trace window, such as another Toolbar button. The Help topic 

will be shown for the item you clicked.  

Shortcut      

Toolbar:   

Keys:      SHIFT+F1  
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8. Editing Tools 

8.1 Centerline 
Choose this option to drawn the centerline - rather than the outline - of the drawing. This is 

particularly useful for tracing line drawings (refer to the "outline" sample in the Examples folder, and 

load the "outline.csf"settings file to see the settings that were used for this case). 

8.2 Corner Always Threshold 
An angle (in degrees, real number) used, in conjunction with the "corner threshold" to 

define a corner in Autotrace. If the angle at a pixel is less than this value, it is considered a 

corner, even if it is within "corner-surround" pixels of another corner (default value = 60). 

8.3 Corner Surround 
Number of pixels around a given point used to determine if that point is a corner (default 

value = 4). 

8.4 Corner Threshold 
An angle (in degrees, real number) used to define a corner in AutoTrace. If a pixel, its 

predecessor(s) and its successor(s) meet at an angle smaller than this value, it is deemed to 

be a corner (default value = 100). 

A point is consider by AutoTrace to be a corner if (1) the angle defined by the "corner 

surround" points coming into it and going out from it is less than this “corner threshold” (in 

degrees), and no point within "corner surround" points has a smaller angle; or (2) the angle 

is less than "corner always threshold" (in degrees). 

8.5 Curve Fit Threshold 
If the maximum distance (in pixels) between the fitted curve and the original curve exceeds 

this value (real number), then the fitting spline will be subdivided (default value = 2.0). 

8.6 Despeckle Level 
Despeckling is the process of removing feature contours that enclose only a few pixels. An increase 

of the despeckling level by one doubles the size of features that are resolved. The default value for 

this parameter is zero (no despeckling). Increasing this parameter will generally decrease both the 

number of vectors and the size of the resulting vector file, at the cost of gradually smoothing out 

global features and reducing the number of distinct colors in the vectorized image. 

8.7 Feature Blending 
Together with the despeckle level (which must be set to a non-zero value for this feature to be 

operative), the value of this parameter determines how neighboring pixels will be merged to define 

a vector contour. Larger values tend to blur individual features more, while smaller (tighter) values 

allow for more detail to be retained in the final tracing.  

8.8 Line Threshold 
If the spline is not more than this distance in pixels (real number) from the straight line defined by 

the spline endpoints, then a straight line is output, rather than a spline (default value = 1.0).< 

/FONT >  

8.9 Line Width Weight 
Weight factor (real number) for fitting the line width (default value = 6.0).  

afxc5tiu.htm
afxc5tiw.htm
afxc5tiw.htm
afxc5tiw.htm
afxc5tiv.htm
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8.10 Median Filter 
Click this button to reduce pixel-to-pixel noise using an image median filter. This is an adjunct to 

despeckling to reduce the pixelation of the image and make it smoother prior to vectorization. 

8.11 Palette 
Click this button to open a color palette for choosing the background image color that will 

be ignored during processing. 

8.12 Preserve Line Width 
Choose this option to preserve line width prior to contour thinning during centerline fitting.  

8.13 Reduce Color Count 
Click this button to reduce the color count to the number entered. A sophisticated color 

quantization is applied to reduce the number of colors and preserve as much of the image 

detail as possible. 

8.14 Remove Adjacent Corners 
Choose this option to remove adjacent corners. This prevents two corners from being next to each 

other, which is desirable to assure the continuity of the curve fit. 

8.15 Vectorize 
Click this button to convert the raster image into a vectorized image. This allows you to view the 

vectorized image before you save it to a vector format file. The process may require several 

iterations with various settings changes before you arrive at a suitable vector image that you want 

to save. 

9. Dialogs and Toolbars 

9.1 File Open 
The following options allow you to specify which file to open:  

File Name  

Type or select the filename you want to open. This box lists raster (bitmap) files with the extension 

you select in the List Files of Type box.  

List Files of Type  

Select the type of raster file you want to open. The supported file types are:  

*.bmp; *.gif; *.jpg; *.ico  

Drives 

Select the drive in which Win32Trace stores the file that you want to open.  

Directories 

Select the directory in which Win32Trace stores the file that you want to open.  

9.2 File Save As 
The following options allow you to specify the name and location of the file you're about to save:  

File Name  

Type a new filename to save a document with a different name. Win32Trace adds the extension 

you specify in the Save File As Type box.  

Save In 

Select the drive and folder in which you want to store the document. 
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Save As Type: 

Win32Trace allows you to save the vector graphics file in a variety of different formats: 

 File Type Extension 

 Encapsulated PS  EPS 

 Adobe Illustrator  AI 

 Computer Graphics Metafile  CGM 

 Enhanced Metafile  EMF 

 Windows Metafile  WMF 

 HP Plotter File  PLT 

 Scalable Vector Graphics  SVG 

 Drawing Interchange File  DXF 

 Portable Document Format  PDF 

 

9.3 Main Toolbar 

 

The toolbar is displayed across the top of the application window, below the menu bar. The toolbar 

provides quick mouse access to many tools used in Win32Trace,  

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).  

ClickTo 

Open a new document.  

Open an existing document. Win32Trace displays the Open dialog box, in which you can 

locate and open the desired file.  

Save the active document or template with its current name. If you have not named the 

document, Win32Trace displays the Save As dialog box.  

Print the active document.  

Remove selected data from the document and stores it on the clipboard.  

Copy the selection to the clipboard.  

Insert the contents of the clipboard at the insertion point.  

9.4 Status Bar 

 

The status bar is displayed at the bottom of the Win32Trace window. To display or hide the 

status bar, use the Status Bar command in the View menu. 

The left area of the status bar describes actions of menu items as you use the arrow keys to 

navigate through menus. This area similarly shows messages that describe the actions of 

toolbar buttons as you depress them, before releasing them. If after viewing the description 

of the toolbar button command you wish not to execute the command, then release the 

mouse button while the pointer is off the toolbar button. 
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The right areas of the status bar indicate which of the following keys are latched down: 

Indicator Description 

CAP The Caps Lock key is latched down. 

NUM The Num Lock key is latched down. 

SCRL The Scroll Lock key is latched down. 

 


